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1.  Introduction 
With this tutorial we would like to make you acquainted with various features of RFEM. Before 
you start working on this tutorial, we recommend you to examine the Introductory Example 
available on the Dlubal website which describes the basic functions of the program. 

Often you will have several options to achieve your targets. Depending on the situation and 
your preferences, different ways may be useful. We would like to invite you to play with the 
software to learn more about the possibilities of the program. With this example we want to 
encourage you to find out useful functions in RFEM. 

The following example represents a mixed construction built of concrete and steel elements. 
We want to calculate the model for the load cases self-weight, live load, snow, wind and imper-
fections according to linear static and nonlinear second-order analysis. 

You can enter, calculate and evaluate the example of this tutorial also with demo restrictions – 
maximum two surfaces and twelve members. Therefore, you may understand that the model 
meets the demands of realistic construction projects only to some extent. With the features 
presented we just want to show you how you can define model and load objects in various 
ways. 

We will use the generator for ASCE load combinations integrated in RFEM. 

With the 90-day trial version, you can work on the model without any restriction. After that pe-
riod, the demo mode will be applied so that saving data is no longer possible. In this case, you 
should allow for enough time (approximately two to three hours) to enter the data and try the 
functions without stress. 

It is easier to enter data if you use two screens, or you may print the description to avoid 
switching between the displays of PDF file and RFEM input.  

The text of the manual shows the described buttons in square brackets, for example [Apply]. 
At the same time, they are pictured on the left. In addition, expressions used in dialog boxes, 
tables and menus are set in italics to clarify the explanations. Input required is written in bold 
letters. 

You can look up the description of program functions in the RFEM manual that you can down-
load on the Dlubal website. 

 

 

 

https://www.dlubal.com/en-US/downloads-and-information/examples-and-tutorials/introductory-examples-and-tutorials
https://www.dlubal.com/en-US/downloads-and-information/documents/manuals?category=rfem
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2.  System and Loads 
 

2.1 Sketch of System 
Our example is a reinforced concrete structure to which a steel construction is attached. 

 

Figure 2.1: Structural system 

The reinforced concrete structure is a substructure consisting of a floor slab with downstand 
beam, a semicircular shell and two round columns. The structural system is built partially in the 
earth. 

The steel frame is a monopitch roof construction stiffened with a diagonal. 

As mentioned above, the model represents a rather "abstract" structure that can be designed 
also with the demo version whose functions are restricted to a maximum of two surfaces and 
twelve members. 

2.2 Materials, Thicknesses and Cross-Sections 
We use Concrete f’c = 4000 psi (ACI 318-19), Steel A992, and Steel A36 as materials. 

The thickness of walls and floors is 8 in each. Both concrete columns have a diameter of 20 in. 
The beam has a width of 10 in and height of 15 in. 

We use W 12x65 cross-sections for the left and right steel frames of the monopitch roof struc-
ture. Both purlins are defined with W 10x49 cross-sections. The bracing diagonal consists of a 
single angle L 6x6x0.75 with equal legs. 
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2.3 Load 

Load case 1: self-weight and finishes 
In the first load case, the self-weight of the model including its floor structure of 0.030 kip/ft2 is 
applied. We do not need to determine the self-weight manually. RFEM calculates the weight 
automatically from the defined materials, surface thicknesses and cross-sections. 

Earth pressure is acting additionally on the semicircular wall. The load ordinate at the bottom 
of the wall is determined for a gravel backfill as follows: q = 0.010 kip/ft3 * 12 ft = 0.120 lb/ft2. 

The roof load (roofing, supporting structure) is assumed with 0.025 kip/ft2. 

Load case 2: live load 
The floor surface is used as an assembly room bearing an imposed load of 0.060 kip/ft2. 

In addition, a vertically acting linear load of 0.035 kip/ft is taken into account around the open-
ing, representing a loading due to a stair access. 

Load case 3: snow 
The snow load is applied at the roof level assumed to be 0.025 kip/ft2. 

Load case 4: wind 
In our example we analyze wind loading only in direction Y (wind direction: from high to low 
eaves). For simplification we disregard any roof wind loads and apply the wind load as a lateral 
area load to walls on the steel frame that are closed on all sides.  The wind load is assumed to 
be 0.016 kip/ft2. 

The reinforced concrete area is exposed to wind loads only partially. For the column at the 
high eaves side we assume a trapezoidal equivalent load with ordinates 0.010 kip/ft and  
0.200 kip/ft. For the column at the low eaves side we apply a uniform equivalent load of  
0.200 kip/ft. 
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3.  Creating Model 
 

3.1  Starting RFEM 
To start RFEM in the taskbar, we 

click Start, point to All Programs and Dlubal, and then we select Dlubal RFEM 5.xx 

or we double-click the icon Dlubal RFEM 5.xx on the computer desktop.  

3.2 Creating Model File 
The RFEM work window opens showing us the dialog box below. We are asked to enter the 
basic data for the new model. 

If RFEM already displays a model, we close it by clicking Close on the File menu. Then, we 
open the General Data dialog box by clicking New on the File menu. 

 
Figure 3.1: Dialog box New Model - General Data 

We write Tutorial in the Model Name box. As Description, we enter Construction consisting of 
concrete and steel. We always have to define a Model Name because it determines the name 
of the RFEM file. The Description box does not necessarily need to be filled in. 

In the Project Name box, we select Examples from the list if not already set by default. The pro-
ject Description and the corresponding Folder are displayed automatically. 

In the dialog section Type of Model, the 3D option is preset. This setting enables spatial modeling. 
We check whether the Positive Orientation of the Global Axis Z is Upward and – by clicking the 
[Details] button –  the Orientation of the Local z-Axis goes Downward. 
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The dialog section Classification of Load Cases and Combinations requires some settings: we se-
lect the entry ASCE 7-16 from the list According to Standard. These specifications are important 
when we combine actions with partial safety factors and combination coefficients conforming 
to standards. 

Then, we select the check box Create combinations automatically. We want to superimpose the 
actions in Load combinations. 

Now, the general data for the model is defined. We close the dialog box by clicking the [OK] 
button. 

The empty work window of RFEM is displayed. 

4.  Model Data 
 

4.1 Adjusting Work Window and Grid 

View 
First, we click the [Maximize] button on the title bar to enlarge the work window. We see the 
axes of coordinates with the global directions X, Y and Z displayed in the workspace. 

To change the position of the axes of coordinates, we click the button [Move, Zoom, Rotate] in 
the toolbar above. The pointer turns into a hand. Now, we can position the workspace accord-
ing to our preferences by moving the pointer and holding the left mouse button down.  

Furthermore, we can use the hand to zoom or rotate the view: 

• Zoom: We move the pointer and hold the [Shift] key down. 

• Rotation: We move the pointer and hold the [Ctrl] key down. 

To exit the function, different ways are possible: 

• We click the button once again. 

• We press the [Esc] key on the keyboard. 

• We right-click into the workspace. 

Mouse functions 
The mouse functions follow the general standards for Windows applications. To select an ob-
ject for further editing, we click it once with the left mouse button.  We double-click the object 
when we want to open its dialog box for editing. 

When we click an object with the right mouse button, its shortcut menu appears showing us 
object-related commands and functions. 

To change the size of the displayed model, we use the wheel button of the mouse. By holding 
down the wheel button we can shift the model directly. When we press the [Ctrl] key addition-
ally, we can rotate the structure. Rotating the structure is also possible by using the wheel but-
ton and holding down the right mouse button at the same time. The pointer symbols shown 
on the left show the selected function. 
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Grid 
The grid forms the background of the workspace. In the dialog box Work Plane and Grid/Snap, 
we can adjust the spacing of grid points. To open the dialog box, we use the button [Settings 
of Work Plane]. 

 
Figure 4.1: Dialog box Work Plane and Grid/Snap 

Later, for entering data in grid points, it is important that the SNAP and GRID options in the sta-
tus bar are set active. In this way, the grid becomes visible and the points will be snapped on 
the grid when clicking. 

Work plane 
The XY plane is set as work plane by default. With this setting all graphically entered objects 
will be generated in the horizontal plane. The plane has no significance for the data input in 
dialog boxes or tables. 

Notice the Origin of Work Plane to X, Y, and Z coordinates are set to 0.00/0.00/0.00 respectively. 

Change the Space b and h under the Grid Point Spacing to 5.00 ft each. 

We close the dialog box with the [OK] button and start with the model input. 
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List button for plane surfaces 

4.2 Creating Surfaces 
It would be possible to define corner nodes in the graphic or table first to connect them with 
lines which we can use to create surfaces. But in our example we use the direct graphical input 
of lines and surfaces. 

4.2.1 Floor 
The floor surface consists of a rectangular and a semicircular surface. 

4.2.1.1 Defining Rectangular Surface 

Rectangular slabs are frequently used structural components. To create rectangular plates 
quickly, 

we click Model Data on the Insert menu, then we point to Surfaces, Plane and  
Graphically and select Rectangle, 

or we use the corresponding list button for the selection of plane surfaces. We click the arrow 
button [] to open a pull-down menu offering a large selection of surface geometries. 

With the menu item [Rectangle] we can define the plate directly. Related nodes and lines will 
be created automatically. 

After selecting this function, the dialog box New Rectangular Surface opens. 

 
Figure 4.2: Dialog box New Rectangular Surface 

The Surface No. of the new rectangular plate is specified with 1. It is not necessary to change 
this number. 

As Material, we want to add Concrete f’c = 4000 psi | ACI 318-19. We make this addition by 
means of the [Material Library] button. 
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Figure 4.3: Material Library 

In the Material Library dialog box, we change the Standard group to ACI. Here we can select 
Concrete f’c = 4000 psi in the Material to Select list. Click [OK] to save these material changes. 

We are now back in the New Rectangular Surface dialog box. The Thickness of the surface is 
Constant. We increase the value d to 8 in, either by using the spin box or by direct input. 

In the dialog section Surface Type, the Stiffness is preset appropriately with Standard. 

We close the dialog box with the [OK] button and start the graphical input of the slab. 

We can make the surface definition easier when we set the view in –Z-direction (top view) by 
using the list button shown on the left. The input mode will not be affected. 
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To define the first corner, we click with the left mouse button into the coordinate origin (co-
ordinates X/Y/Z 0.00/0.00/0.00). The current pointer coordinates are displayed next to the reticle. 

Then, we define the opposite corner of the slab by clicking the grid point with the X/Y/Z coor-
dinates 25.00/20.00/0.000. 

 
Figure 4.4: Rectangular surface 1 

RFEM creates four nodes, four lines and one surface. 

As we don't want to create any more plates, we quit the input mode by pressing the [Esc] key. 
We can also use the right mouse button to right-click in an empty area of the work window. 

Show numbering 
If we want to display the numbering of nodes, lines and surfaces, we right-click into an empty 
space of the work window. A shortcut menu with useful functions appears. We activate the 
Numbering (see figure shown on the left). 

We can use the Display tab in the navigator to control the numbering of objects in detail. 

 
Figure 4.5: Display navigator for numbering 

 
 

Show numbering in shortcut menu 
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4.2.1.2 Creating Arc 

Now, we need to define an area that is limited by a circular arc. 

We click the arrow [] of the list button for lines available in the toolbar to open the pull-down 
menu offering tools for special line types. We select the entry Arc via Three Nodes. 

 
Figure 4.6: List button for lines - Arc via Three Nodes 

In the work window, we click the following nodes one after the other: node 3, the grid point 
with the coordinates 35.00/10.00/0.00 and node 2. After clicking the last node, the arc will be 
created as line 5. 

 

Figure 4.7: Defining a circular arc with three points 

To quit the input mode, right click the mouse button. 
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4.2.1.3 Adjusting Floor Surface 

As the demo version allows for the definition of only two surfaces, we cannot define the semi-
circular surface as a new surface. Therefore, we extend the rectangular surface to a general 
plane surface enclosing the arc area. 

We double-click surface 1 in the work window to open the dialog box Edit Surface. 

 
Figure 4.8: Modifying boundary lines 

We have two input options: 

• In the Boundary Lines No. box, we can enter the numbers of the new border lines 1, 3, 4 
and 5 manually. 

• We can use the [Select] button shown on the left to select the new boundary lines graph-
ically in the work window. But first it is necessary to empty the preset list in the selection 
window Edit Surface by clicking the button [Clear]. 

Now, the floor surface looks like the figure below. 

 
Figure 4.9: Floor slab 
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4.2.2 Wall 
Copy the arc 
The most comfortable way to create a curved surface is copying the circular arc by specifying 
particular settings for the copy process. 

We click arc line 5 with the left mouse button (single click) to select it. The line is now displayed 
with a different color. Yellow is preset as selection color for black backgrounds. 

We use the toolbar button shown on the left to open the dialog box Move or Copy. 

 
Figure 4.10: Dialog box Move or Copy 

We increase the Number of copies to 1: With this setting the arc won't be moved but copied.  
As the wall is 15 ft high (system line), we enter the value -15.00 ft for the Displacement Vector 
in dZ. 

Now, we click the [Details] button to specify more settings. 
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Figure 4.11: Dialog box Detail Settings for Move/Rotate/Mirror 

In the dialog section Connecting, we select the check box of the following option: 

  Create new surfaces between the selected lines and their copies 

Then, we select surface 1 from the list to define it as Template surface. In this way, the proper-
ties of the floor slab (material, thickness) are preset for the new wall surface. 

We close both dialog boxes by clicking the [OK] button. 
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Set the isometric view 

We use the toolbar button shown on the left to set the [Isometric View] because we want to 
display the model in a graphical 3D representation. 

 
Figure 4.12: Model in isometric view with navigator and table entries 

Checking data in navigator and tables 
All entered objects can be found in the directory tree of the Data navigator and in the tabs of 
the table. The entries in the navigator can be opened by clicking the [+] sign (like in Windows 
Explorer). To switch between the tables, we click the individual table tabs. 

In the navigator entry Surfaces and in Table 1.4 Surfaces, we see the input data of both surfaces 
in numerical form (see Figure 4.12). RFEM created the wall as a quadrangle surface, i.e. a shell 
that is limited by four lines. 
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List button for openings 

4.2.3 Opening 

4.2.3.1 Creating Opening 
Now, we insert a rectangular opening into the floor slab. The data input is easier when we  
reset the [View in Reverse Z-direction]. 

We can apply the opening directly, which means without defining lines first. We use the list 
button for openings available in the toolbar and select the entry Rectangle. 

We set the first opening node in grid point 5.00/15.00/0.00. The second node is defined in 
grid point 15.00/10.00/0.00. 

The opening is too small. We will adjust its length in the next step. 

 
Figure 4.13: Defining the rectangular opening 

We close the input mode with the [Esc] button or with a right-click into the empty workspace. 
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4.2.3.2 Adjusting Opening 
The length of the opening is 11 ft. We select nodes 11 and 12 one after the other by holding 
down the [Ctrl] key when clicking. 

We open the dialog box Edit Node with a double click on one of these nodes. 

 
Figure 4.14: Dialog box Edit Node 

Both nodes are listed in the Node No. box. We correct the Coordinate X by entering 16 ft, and 
then we confirm the input with [OK]. Now, the opening has an appropriate length. 

Alternative: It is also possible to apply the opening instantly without modifying coordinates 
when we use an adjusted grid.  We can use the shortcut menu when we right click on the GRID 
button available in the status bar to modify the grid spacing. We can quickly open up the Work 
Plane and Grid/Snap dialog box by selecting Edit.  Here we can reduce the Grid Point Spacing to 
1 ft (see Figure 4.1, page 10). 

Now, the input of surfaces is complete. 
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4.3 Creating Concrete Members 

4.3.1 Columns 
Member elements depend on lines: By creating a member a line is generated automatically. 

Changing the work plane 
We want to define the columns graphically, so we need to shift the work plane from the hori-
zontal to the vertical plane. To set the [Work Plane YZ], we click the second of the three plane 
buttons in the toolbar. 

We reset the [Isometric View]. Now, we can see that the input grid is spanned in the plane of 
the two columns (see Figure 4.18). 

Definition of cross-section 
We click the list button [New Members Single] to open the dialog box New Member. 

 
Figure 4.15: Dialog box New Member 

It is not necessary to change the default settings. We only have to create a Cross-Section. To de-
fine the cross-section at the Member start, we click the [Library] button. The cross-section data-
base appears. 
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Figure 4.16: Cross-Section Library 

In the dialog section Parametric - Massive, we select the cross-section type Circle. Another  
dialog box appears. 

 
Figure 4.17: Dialog box Solid Cross-Sections - Circle 

We define the column diameter D with 20 in. 

For solid cross-sections we select 3 - Concrete f’c = 4000 psi | ACI 318-19 under Material. 

We can use the [Info] button to check the properties of the cross-section. 
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We click [OK] to import the cross-section values and return to the initial New Member dialog 
box. Now the Member start box shows the new cross-section. We close the dialog box with 
[OK] to set the columns graphically. 

Graphical definition of members 
We define the footing of the front column by clicking the grid point 0.00/0.00/-15.00. 

The top end of the column is set into node 1. 

 
Figure 4.18: Defining the footing of the second column 

The input command Define member is still active. Therefore, we can continue with the defini-
tion of the rear column. 

We place the footing of the second column into the grid point 0.00/20.00/-15.00. The 
column's top end is then defined in the grid zero point which is node 4. 

To quit the input mode, we use the [Esc] key. We can also right-click into the empty work win-
dow. 
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4.3.2 Rib 
In the next step, we enter the downstand beam below the ceiling. 

Modification of line properties 
We double-click line 2 to open the dialog box Edit Line. We change to the second tab Member 
where we select the check box of the option Available (see Figure 4.19). 

The dialog box New Member opens again. 

 
Figure 4.19: Dialog box New Member 

This time we click the [New] button to define a cross-section at the Member start. 

In the upper part of the dialog box New Cross-Section (see Figure 4.20), we select the massive 
REC cross-section table. The dialog box Solid Cross-Sections - Rectangle opens where we define 
the width b with 10 in and the depth h with 15 in. 
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Figure 4.20: Dialog box Solid Cross-Sections - Rectangle 

We click [OK] to import the cross-section values to the dialog box New Cross-Section. Again, we 
select Concrete f’c = 4000 psi | ACI 318-19 from the Material drop-down. 

We click [OK] and return to the initial dialog box New Member. Now the Member start box 
shows the rectangular cross-section. 
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Definition of rib 
In RFEM we can model a downstand beam with the member type Rib. We just change the 
Member Type in the dialog box New Member: We select the entry Rib from the list. 

 
Figure 4.21: Changing the member type 

With a click on the button [Edit Member Type] we open the New Rib dialog box. 

 
Figure 4.22: Defining the rib 
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We define the Position and Alignment of the Rib On +z-side of surface. This is the bottom side 
of the floor slab. 

For the Effective Width we specify L/8 for both sides. RFEM will find the surfaces automatically. 

We close all dialog boxes with the [OK] button and check the result in the work window. 

Display options 
RFEM displays the rib as a member that is eccentrically arranged. As the transparent rendering 
model does not show surface thicknesses, we set the Solid Display Model by means of the list 
button shown on the left. This display mode helps us to check the placement of the rib. 

In addition, we set the rendering option Filled incl. thickness available in the Display navigator. 

 
Figure 4.23: Graphical representation of solid model 

To adjust the display, we use the button [Move, Zoom, Rotate] (see "mouse functions" on page 9). 
The pointer turns into a hand. When we hold down the [Ctrl] key additionally, we can rotate 
the model by moving the pointer. 

For the following input we reset the mode of the Solid Transparent Display Model. We also reset 
the rendering for surfaces to Filled provided in the Display navigator in order to hide thicknesses. 
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4.4 Defining Supports 
The model is still without supports. In RFEM we can assign supports to nodes, lines, members 
and surfaces. 

4.4.1 Nodal Supports 
The columns are supported on their footing in all directions but without restraint. 

We select the bottom nodes of the columns by drawing a window from left to right across the 
area including the nodes X and Y. Nodes 13 and 14 are now selected. Then we click the toolbar 
button [New Nodal Support] to open the dialog box New Nodal Support. 

 
Figure 4.24: Selecting column nodes with window 

Both node numbers 13 and 14 are shown in the Node No. box 

We modify the type of the support because the preset support type 1 results in a restraint 
about the longitudinal member axis. With a click on the button [New] (see Figure 4.25) we 
open another dialog box. 
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Figure 4.25: Defining degrees of freedom 

In the second dialog box New Nodal Support, we remove the check mark of the Restraint for  
rotation φZ’. 

We confirm the dialog boxes with [OK]. Now, we see support symbols displayed on the model. 
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4.4.2 Line Supports 
The bottom line of the curved wall is supported as well. This time, we choose another way to 
enter support data. First, we define the support properties. Then, we assign them to the object 
graphically. 

With a click on the button [New Line Support] we open the dialog box New Line Support. 

The option Hinged is preset as Type of Support. The first three selected check boxes are indicat-
ing that a support is available in the directions X, Y and Z. The final three boxes are not select-
ed because the hinged support type has no restraint about X, Y and Z. 

We confirm the dialog box with [OK] because the hinged support is adequate for our example. 

 
Figure 4.26: Dialog box New Line Support 

RFEM displays a support symbol next to the mouse pointer. It becomes a reticle as soon as we 
approach a line. The number of the corresponding line is displayed in the status bar. We set 
the support on the curved line 6. 

Now, the input of the model's reinforced concrete construction is complete. 

 
Figure 4.27: Reinforced concrete structure with supports 
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4.5 Creating Steel Members 

4.5.1 Frame 
Now we enter the steel construction. First, we define the frame that lies in the plane of the two 
columns. It is helpful to use a so-called visibility for this plane: This type of partial view allows 
us to work in a particular zone of the model and we are not disturbed by objects that lie within 
another plane. 

Creation of visibilities 
We set the Views tab in the navigator. A number of visibilities is already available. They were 
Generated by RFEM based on the data we entered. 

The button [Visibility by Window] makes it possible to abstract a specific zone from the model 
graphically: We activate the function and draw a window from the left to the right, completely 
enclosing both column members. 

Please note: If you pull up the window from the left to the right, the visibility contains only ob-
jects that are completely within this window. If you pull up the window from the right to the 
left, the visibility additionally contains those objects that are cut by the window. 

Now we can see that the rest of the model (floor, wall) is displayed with a lower color intensity. 
The corresponding objects cannot be edited. 

 
Figure 4.28: Creating a visibility by window 

Changing the origin of the work plane 
Plane YZ is still set as the work plane, which is appropriate for defining the frame of the mono-
pitch roof. Also the origin of the work plane is convenient for our purpose. However, we want 
to show you how you can adjust the work plane. Therefore, we modify the position of the work 
plane origin. 

We click the toolbar button [Set Origin]. Then, in the work window, we select node 1, which is 
the head of the front column, to be the new origin of the work plane. The reticle of the grid 
changes its position. 
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Figure 4.29: New origin in node 2 

4.5.1.1 Defining Members Continuously 
We want to create the monopitch roof frame as a polygonal chain. We open the list button 
[New Member] and select the menu item Member Continuous. 

The dialog box New Member opens. First, we confirm the Member Type is set to Beam. 

We create a cross-section for the Member start by using the [Import from Cross-Section Library] 
button. The dialog box Cross-Section Library opens where we click the button [I-Sections] un-
der the Rolled section. 

 
Figure 4.30: Selecting I-Section from Cross-Section Library 

Then, in the dialog box Rolled Cross-Sections - I-sections (see Figure 4.31), we select the AISC 
under the Manufacturer/Standard group. 

Then we select W 12x65 from the cross-section table. 
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Figure 4.31: Selecting W 12x65 in the library 

We make sure that Steel A992 | ANSI/AISC 360-16: 2016 is preset as Material. If not, we click 
the [Edit] button in that section of the dialog box and bring up the Material Library dialog box. 

 
Figure 4.32: Selecting Steel A992 Material 

In the Filter section, we set ASTM as Standard group and ANSI/AISC 360-16:2016 as Standard. Then 
we select Steel A992 from the Material to Select list. We confirm all dialog boxes with [OK]. 
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Back in the work window, we define the three frame members in one go by clicking the follow-
ing nodes and grid points: 

• Node 4 

• Grid point 0.00/20.00/10.00 (grid origin has been modified) 

• Grid point 0.00/0.00/10.00 (roof inclination will be adjusted later) 

• Node 1 

 
Figure 4.33: Defining members continuously 

When the last node is defined, we right-click twice into the empty work window to quit the  
input mode. 

Both columns in our model are connected rigidly to the floor nodes 4 and 1. Though this kind 
of restraint can hardly be built in reality, we do without a modeling of release properties in our 
example and accept this simplification. 
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4.5.1.2 Chamfering Horizontal Beams 
The monopitch roof has an inclination of 8°. That's why we have to adjust the horizontal beam. 

We draw a selection window across member 5 comprising both end nodes. Then, in the toolbar 

we select Chamfer on the Edit menu 

to open the dialog box 3D Chamfer. 

 

Figure 4.34: Adjusting the inclination of the horizontal beam 

We want to modify the inclination of the beam by -8° About axis X. We have to enter a nega-
tive value because the objects will be rotated counterclockwise about the axis X. The shearing 
is applied in vertical direction Z. Finally, we define the 1st point of the rotation axis by using the 
[Select] button. We select node 15 having the coordinates 0.00/20.00/10.00 and confirm the 
input with [OK]. 
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4.5.1.3 Connecting Beams with Hinges 

Hinge definition 
The horizontal beam cannot transfer any bending moments into the columns because of its 
connection type. Therefore, we define a hinge that we assign to both sides of the beam later. 

This time we use the Data navigator: We right-click the entry Member Hinges and select New 
Member Hinge in the shortcut menu. 

 
Figure 4.35: Opening the dialog box New Member Hinge in the Data navigator 

In the dialog box New Member Hinge, displacements or rotations can be selected that are re-
leased at the member end. In our example, those are the rotations φy and φz. Thus, no bending 
moments can be transferred at the node. 

We close the dialog box by clicking the [OK] button without modifying any data. 

Hinge assignment 

It would be possible to double click the member to open the dialog box Edit Member and as-
sign the hinges. However, we use a special function that is available in the following menu: 

On the Insert menu, we select Model Data, point to Member Hinges and select Assign to 
Members Graphically. 

The dialog box Assign Member Hinges to Members Graphically appears. We open the list and se-
lect member hinge 1 that we have just defined. Then, we click [OK]. 

 
Figure 4.36: Dialog box Assign Member End Hinges to Members Graphically 

We see in the work window that RFEM has applied a one-third division to the members (see 
Figure 4.37). By clicking the end of a member we can define the hinge graphically at that 
member end. However, we click member 5 in its middle area to assign the hinge to both sides. 
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Figure 4.37: Assigning hinges graphically 

4.5.1.4 Reverse Member Orientation 
For the graphical representation it may be comfortable for us when the member orientation of 
columns is directed from the bottom to the top. Therefore, we change the orientation of the 
right steel column, using a function of the member shortcut menu. 

Moving the pointer near member 6, we can see the orientation arrow appearing on the mem-
ber. We right-click the member and open its shortcut menu where we select the menu item  
Reverse Member Orientation. 

 
Figure 4.38: Shortcut menu of member 
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4.5.1.5 Copying Frame 
The second frame of the monopitch roof can be created very quickly as a copy. 

We draw a selection window across the frame, enclosing members 4 to 6. Please take care not 
to include any of the concrete columns! If necessary, you can rotate the model to set a more 
favorable view. We can also click the members one after the other by holding down the [Ctrl] 
key. 

Before we create the copy, we set the [Work Plane XZ] so that we are able to copy the structure 
out of the frame plane. 

We press the [Ctrl] key. Now, we grab the selection near the foot point of the higher column 
(node 1) and shift it to the arc end at the wall top. The [+] symbol next to the mouse pointer 
indicates that the objects are being copied. As soon as the coordinates of the grid point 
25.00/0.00/0.00 are displayed in the status bar, we release the mouse button. 

 

Figure 4.39: Copying frame by drag-and-drop 

Nodes and lines are merged automatically with already defined objects. 
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4.5.2 Purlins 

4.5.2.1 Defining Members Individually 
Again, we use the list button [New Member] for the definition of both purlins. We select the 
option Single Member and open the dialog box New Member. 

We set the Member Type to Beam. We define a cross-section for the Member start by using the 
[Import from Cross-Section Library] button again. 

The dialog box Cross-Section Library opens where we click the button [I-Sections] under the 
Rolled section (see Figure 4.30, page 32). 

Then, in the dialog box Rolled Cross-Sections - I-sections, we select the AISC under the Manufac-
turer/Standard group. Then we select W 10x49 from the cross-section table.  

We make sure that Steel A992 | ANSI/AISC 360-16:2016 is set as Material. 

 
Figure 4.40: Selecting W 10x49 in the library 

We confirm all dialog boxes with [OK]. 

We define the purlin at the lower eaves by clicking nodes 15 and 19 one after the other. 

Then we click nodes 16 and 20 to create the second purlin. 
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Figure 4.41: Defining purlin members 

To quit the input mode, we use the [Esc] key or right-click into the empty work window. 
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4.5.2.2 Connecting Members Eccentrically 
We want to connect the purlins eccentrically to the frame columns. Thus, we shorten the 
system line by half of the cross-section height of the W 12x65 columns. 

Definition of eccentricity 

We double-click the purlin at the high eaves (member 11). In the dialog box Edit Member, we 
change to the dialog tab Options. In the dialog section Member Eccentricity, we click the [New] 
button to open the dialog box New Member Eccentricity. 

 
Figure 4.42: Dialog box New Member, tab Options and dialog box New Member Eccentricity 

We select the option Transverse offset from cross-section of other object. In our example, the  
Object is the column: We use the [Select] function to select Member 6 graphically. 

Then we define the Axis offset in direction of the positive cross-section axis z. 

Finally, in the dialog section Axial offset from adjoining members, we select the check boxes for 
Member start and Member end to arrange the offset on both sides. 

After confirming all dialog boxes we can check the result with a maximized view (for example 
zooming by rolling the wheel button, moving by holding down the wheel button, rotating by 
holding down the wheel button and keeping the right mouse button pressed). 
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Figure 4.43: Eccentric connection of purlin in zoomed view 

Apply eccentricity to another member 
To transfer the eccentricity to the second purlin, we use the input tables. 

We set table 1.17 Members listing numerically the member data of all members that we have 
defined so far. When we click into table row 10, we see that the second purlin is highlighted in 
the work window and displayed in the selection color. 

 
Figure 4.44: Assigning eccentricity in table 1.17 Members 

We place the pointer into column I and enter 1, which is the number of the eccentricity that we 
have just defined. We can also select it from the list. 

After leaving the table cell with the [Tab] or [↵] key, we see the modification displayed in the 
graphic. 

In the same way, it would be possible to define another eccentricity for the horizontal beams. 
However, as these members are connected to the column webs, we want to neglect those  
additional moments in our example. 
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4.5.3 Diagonal 
The final member that we insert is a diagonal for stiffening. Generally, bracings are defined 
crosswise but the calculation in the demo version only allows for 12 members. The member 
type will be defined as a Truss which is a beam member with moment releases at both ends. 

4.5.3.1 Defining Member 
With the button [Single Member] we open again the dialog box New Member where we select 
the entry Truss from the Member Type list. 

We define a cross-section for the Member start by using the [Import from Cross-Section Library] 
button. 

The dialog box Cross-Section Library opens where we click the button [Angles] under the Rolled 
section. 

 
Figure 4.45: Cross-Section Library 

Then, in the dialog box Rolled Cross-Sections - Angles, we select AISC under the Manufacturer/ 
Standard group. Then we select L 6x6x3/4 from the cross-section table (see Figure 4.46). 

We create a new material by selecting the [Import from Material Library] button. Here we will 
choose ASTM under the Standard group dropdown and select Steel A36: ANSI/AISC 360-05: 
2005-03 from the list. 
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Figure 4.46: Defining tension member with cross-section L 6x6x3/4 and material Steel A36 

We confirm all dialog boxes with [OK]. 

Then we click the nodes 1 and 15 one after the other to define the diagonal. 

 
Figure 4.47: Defining the diagonal 

To quit the input mode, we use the [Esc] key or right-click into the empty work window. 
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4.5.3.2 Rotating Member 
A buckling member adds to stiffness only by its cross-sectional area. Thus, seen from a struc-
tural point of view, the rotation of the member is not irrelevant. For the rendered view, how-
ever, we want to rotate the angle section. 

We double-click member 12 to open the dialog box Edit Member where we define a member 
rotation of 90°. 

 
Figure 4.48: Defining a member rotation 

Again, we can check the result in a maximized view by using the zoom and moving function 
(see page 9). 

 
Figure 4.49: Rotated angle member in zoomed view 
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Undo/restore 
If you want, you can [Undo] the member rotation in this view in order to check the initial posi-
tion of the cross-section. With the default functions Undo and Redo that you already know 
from Windows applications we can undo or restore input data in RFEM, too. 

 
Figure 4.50: Buttons Undo and Redo 

Cancel visibility mode 
The parts of the model displayed in RFEM as transparent objects can be reactivated in the 
Views navigator: With a click on the button [Cancel Visibility Mode] all objects are fully dis-
played again. With the toolbar button [Isometric View] we can reset the spatial full view. 

 

Figure 4.51: Full view of model 
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Adjusting the color assignment 
The Display navigator provides some options to display Colors in Graphics According to particular 
criteria. The default setting is the display of material colors. 

You can click through the menu items to see how the display changes. With the Cross-Section 
option, for example, we can distinguish the cross-section types at a glance. 

 
Figure 4.52: Distinguishing cross-sections by colors 

For the following input, we reset the Standard option. 

4.6 Checking Input 

Checking Data navigator and tables 
As mentioned before, RFEM offers us various possibilities to enter model data. The graphical 
input is reflected in both the Data navigator tree and the tables. We can display and hide navi-
gator and tables by selecting Navigator or Table on the View menu. We can also use the cor-
responding toolbar buttons. 

In the tables, the model objects are organized in numerous tabs. Graphics and tables are inter-
active: To find an object in the table, for example a member, we set table 1.17 Members and se-
lect the member in the work window by clicking. We see that the corresponding table row is 
highlighted (see Figure 4.44, page 42). 

We can check the numerical data of our input quickly. 

Saving data 
Finally, the input of model data is complete. To save our file, 

we select Save on the File menu 

or use the toolbar button shown on the left. 
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5.  Loads 
The Data navigator contains the following entries in the folder Load Cases and Combinations: 

• Load cases 
• Actions 
• Combination expressions 
• Action combinations 
• Load combinations 
• Result combinations 

We define the actual loading like self-weight, snow and wind load in load cases. Then, load 
cases are organized in actions and superimposed with partial safety factors according to the 
combination expressions of the Standard (see Chapter 6). 

5.1 Load Case 1: Self-weight 
The first load case contains the permanently acting loads from self-weight, floor structure, 
earth pressure and roof finishes (see Chapter 2.3, page 7). 

We use the [New Surface Load] button to create a load case. 

 
Figure 5.1: Button New Surface Load 

The Edit Load Cases and Combinations dialog box appears. 

 
Figure 5.2: Dialog box Edit Load Cases and Combinations, tabs Load Cases and General 
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Load case no. 1 is preset with the action category Dead. Additionnally, we enter the Load Case 
Description Dead Load. 

5.1.1 Self-weight 
The Self-Weight of surfaces and members in direction Z is automatically taken into account 
when the factor Active is specified with -1.000. 

5.1.2 Floor Structure 
We confirm the input by clicking the [OK] button. The dialog box New Surface Load appears. 

 
Figure 5.3: Dialog box New Surface Load 

We click the [Units and Decimal Places] button at the bottom of this dialog box to launch the 
Units and Decimal Places dialog box. 

Here we will select the Loads tab and adjust the units to what is shown in Figure 5.4. 

We click [OK] to save the changes and exit the Units and Decimal Places dialog box. 
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Figure 5.4: Dialog box Units and Decimal Places 

Back in the New Surface Load dialog box (Figure 5.3), the floor structure is acting as load type 
Force, the load distribution is Uniform. We accept these presettings as well as the setting ZL for 
Global in the dialog section Load Direction. 

In the dialog section Load Magnitude, we enter a value of -0.030 ksf (see Chapter 2.3, page 7). 
Then, we close the dialog box by clicking [OK]. 

Now, we can assign the load graphically to the floor surface: We can see that a small load sym-
bol has appeared next to the pointer. This symbol disappears as soon as we move the pointer 
across a surface. We apply the load to the floor with a click on surface 1. 

 
Figure 5.5: Graphical input of floor load 
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The surface load is not applied to the opening. We can see the non-load bearing area identified 
by the load application symbol. 

We can hide and display the load values with the toolbar button [Show Load Values]. 

To quit the input mode, we use the [Esc] key or right-click into the empty work window. 

5.1.3 Earth Pressure 
The earth pressure stressing the wall is represented by a linearly variable load acting perpen-
dicularly to the surface. This time, we select the curved surface 2 first, and then we open the 
corresponding dialog box for load input by using the [New Surface Load] button. 

 
Figure 5.6: Dialog box New Surface Load 

The load is set as load type Force with the Load Distribution Linear In Z. Thus, we select Local z 
as Load Direction. 

To enter the Load Magnitude, we use the [Select] button to select significant locations on the 
model to which we assign load ordinates: We click Node No. 2 and enter the Magnitude 0 ksf. 
Then, we click the [Select] button again to select Node No. 6 to which we assign the Magnitude  
-0.120 ksf (see Chapter 2.3, page 7). We enter the load with a negative number because the lo-
cal z-axis of the surface is directed to the outside. 

 

 

 



5  Loads 

 

 
Dlubal 

52 RFEM Tutorial © 2020 Dlubal Software, Inc. 

 
 

Display of local axis systems 

 

After confirming the dialog data by clicking [OK], we see the linear surface load displayed in 
the model, increasing downwards and acting perpendicularly on the shell. We use the shortcut 
menu shown on the left (appears when we right-click the surface) to show the local surface axes. 

 

Figure 5.7: Linearly variable surface load (earth pressure) with display of local surface axes 

5.1.4 Roof Load 
The loading due to roof finishes (roofing, supporting structure) is acting as permanent load, 
too. For applying loads acting upon surfaces to the steel construction, RFEM offers us a tool 
that is able to convert area loads into member loads. 

To open the generator dialog box, 

we point to Generate Loads on the Tools menu, and then we select From Area Loads on 
Members via Plane. 

In the Convert Area Loads to Member Loads via Planes dialog box, we specify the following settings 
(see Figure 5.8): 

The Area Load Direction of the roof structure is Global related to the true area ZL with the Area 
Load Magnitude -0.025 ksf (see Chapter 2.3, page 7). 

Then, we define the plane of the area load graphically by means of the [Select] button: In the 
work window, we click the four corner nodes of the roof area 20, 16, 15 and 19 one after the 
other. Finally, we close the selection window with [OK]. 

The roof's supporting structure introduces the roof loading (not displayed in the model) into 
the structural system along the purlins. This means: Both horizontal beams of the monopitch 
roof do not participate in transferring loads from the roof loading. Thus, they must be exclud-
ed from the load generation. We use the [Select] button shown on the left, available in the dia-
log section Remove Influence from - Members parallel to member, to select one of the horizontal 
beams graphically in the work window (member 8 or 5). We click [OK] in the selection window. 
After that, the generator dialog box should look as follows. 
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Figure 5.8: Dialog box Convert Area Loads to Member Loads via Planes 

We confirm the dialog settings with [OK]. An Info dialog box appears showing us information 
about the conversion of area load values into member loads. We confirm this dialog data as well. 

The loading is represented as roof area load. To display the generated loads acting on both 
purlins, we right-click this load and open its shortcut menu where we select the option Display 
Separately. 

 

Figure 5.9: Member loads from area loads on purlins 

Now, the input for the load case Dead Load is complete. 
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5.2 Load Case 2: Live Load 
Before we enter live loads, we create a new load case. To open the corresponding dialog box, 

we point to Load Cases and Combinations on the Insert menu and select Load Case, 

or we use the corresponding button in the toolbar (to the left of the load case list). 

 
Figure 5.10: Dialog box Edit Load Cases and Combinations, tab Load Cases 

For the Load Case Description we enter Live Load. 

We change the Action Category to Live (L). This classification is important for the load factors 
and combination coefficients of the load combinations. 
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5.2.1 Floor Slab 
We choose a new input option to enter the surface load: First, we select floor surface 1 with a 
mouse click. Now, when we open the already familiar dialog box by means of the [New Surface 
Load] button, we can see that the number of the surface is already entered. 

 
Figure 5.11: Dialog box New Surface Load 

The imposed load is acting as load type Force, the load distribution is Uniform. We accept these 
presettings as well as the setting ZL for Global in the dialog section Load Direction. 

In the dialog section Load Magnitude, we enter a value of -0.060 ksf (see Chapter 2.3, page 7). 
Then, we close the dialog box by clicking [OK]. 
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5.2.2 Edge of Opening 
It is easier to apply the linear load to the edge of the opening when we maximize the display of 
this area by using the Zoom function or the wheel button. 

With the toolbar button [New Line Load] to the left of the [New Surface Load] button we open 
the dialog box New Line Load. 

 
Figure 5.12: Dialog box New Line Load 

The line load as load type Force with a Uniform load distribution is acting in the load direction ZL. 

In the dialog section Load Parameters, we enter -0.035 kip/ft. After clicking the [OK] button we 
click line 11 at the edge of the opening (check by display in status bar). 

To quit the input mode, we use the [Esc] key or right-click into the empty work window. 
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5.3 Load Case 3: Snow 
Again, we create a [New Load Case] to enter the snow load. 

 
Figure 5.13: Dialog box Edit Load Cases and Combinations, tab Load Cases 

For the Load Case Description we enter Snow Load. 

We set the Action Category to Snow (S). 

5.3.1 Roof 
To enter the snow load for the monopitch roof, we use a load generator again. To open the 
corresponding dialog box, we point to 

Generate Loads on the Tools menu and select Convert Area Loads to Member Loads 
via Plane. 

In this dialog box (see Figure 5.14) we specify the following settings: 

The Area Load Direction of the roof structure is Global related to the true area ZL with the Area 
Load Magnitude -0.025 ksf (see Chapter 2.3, page 7). 

Then, we define the plane of the area load graphically by means of the [Select] button: In the 
work window, we click the four corner nodes of the roof area 20, 16, 15 and 19 one after the 
other. We close the selection window with [OK]. 

Again, we want to create Member loads, but both monopitch roof beams do not make a con-
tribution to the load transfer (the snow loads are introduced into the structural system by the 
roof's supporting structure via purlins). We use the [Select] button shown on the left, available 
in the dialog section Remove Influence from - Members parallel to member, to select one of the 
horizontal beams graphically (member 8 or 5). 
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List button for loads 

      

 
Figure 5.14: Dialog box Convert Area Loads to Member Loads via Planes 

We confirm the dialog settings with [OK]. An Info dialog box appears showing us information 
about the conversion of area load values into member loads. We confirm this dialog data as 
well. The load is represented as roof area load with a value of 0.025 ksf. 

To display the generated loads acting on both purlins, we can right click on the area load and 
choose Display Separately which is available in the load shortcut menu. In this way, we can 
make visible both member loads of 0.263 kip/ft each. 

5.3.2 Floor 
Snow loading also acts on the semicircular area of the floor surface. As surface 1 is stressed on-
ly partially by snow, we cannot use the function New Surface Load. In the full and trial versions 
of RFEM, it would be advisable to subdivide the floor into two surfaces in order to simply set a 
surface load on the semicircular surface. As the demo version allows only for two surfaces used 
in the model, we choose a more complex input option. 

First, we set the [View in Reverse Z-direction]. Then, we select plane [XY] as our new work plane. 

We define the snow load as Free Polygon Load. We find the corresponding function in the list of 
the toolbar button [New Load] (to the right of the [Surface Load] button). 
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The dialog box New Free Polygon Load opens. 

We define the load to be acting On Surfaces No. 1 and Global related to projected area ZP. In 
contrast to dead loads (like self-weight) which refer to the true area, snow loads must be relat-
ed to the base area (this difference is not significant for horizontal surfaces). 

The load is projected in the XY Plane. 

 
Figure 5.15: Defining new free polygon load by clicking arc points 

We define the Load Position in the work window by using the [Select] button: We start at arc 
node 3 at the top of the arc, and then we use the reticle cursor to click any points on the arc 
line one after the other so that we approach the semicircular surface with a polygonal chain. 
As soon as we reach the arc end at node 2, we close the yellow dialog box with [OK]. 

In the dialog section Corner Point Numbers and Load Magnitudes, we enter the value -0.025 ksf. 

We click [OK]. RFEM puts the load on the semicircular surface. 
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Figure 5.16: Snow loads 

We close the input mode with the [Esc] button or a right-click into the empty workspace. Then, 
we change to the [Isometric View]. 

5.4 Load Case 4: Wind 
We create a [New Load Case] for the wind loads in direction Y. 

 
Figure 5.17: Dialog box Edit Load Cases and Combinations, tab Load Cases 

In the Load Case Description text box, we type Wind Load in the +Y and set the Action Category 
to Wind. 
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5.4.1 Steel Wind Loads 
Again, we use a load generator to enter the wind load applied to the walls that are closed on 
all sides. For simplification of this tutorial, we will only apply a uniform wind load to the walls 
and will disregard any windload on the monopitch roof. To access the familiar load function, 

we point to Generate Loads on the Tools menu and then select Convert Area Loads to 
Member Loads via Plane. 

In the Convert Area Loads to Member Loads via Planes dialog box, we specify the following settings: 

 
Figure 5.18: Dialog box Convert Area Loads to Member Loads via Planes 

After clicking [OK] a dialog box appears showing us information about the generation data. We 
click [OK] to confirm the dialog box. Now, we can see the wind loads displayed as surface loads 
on the model (see Figure 5.21). 

In addition, we can use the option Display Separately available in the load shortcut menu to 
make the member loads visible. 
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5.4.2 Column Loads 
The loads applied to the lower part of the structure will be defined manually. 

Defining a uniform member load 
The wind suction acts on the column at the low eaves side with a constant value. 

We select column member 2 with a mouse click and open the dialog box shown in Figure 5.19 
with the button [New Member Load]. 

The Load Direction is globally related to the true member length in YL. The wind load compo-
nent apportioned to the column is 0.200 kip/ft We enter the value as Load Parameter. 

 
Figure 5.19: Defining wind suction as uniform member load 

We click [OK]. Now we see the member load represented on the column (see Figure 5.21). 

Defining a trapezoidal member load 

Due to a backfill set in a certain zone, the high eave side reveals an asymmetrical load applica-
tion area for wind pressure. Thus, the load distribution on the column is variable. 

We select column member 1 and use the button [New Member Load] to open the dialog box 
New Member Load again (see Figure 5.20). 

Again, the Load Direction is defined globally in YL, but the Load Distribution is Trapezoidal. 
With this setting two Load Parameters become accessible: We enter 0.010 kip/ft for the mem-
ber start p1 and 0.200 kip/ft for the member end p2. (We defined the columns from bottom to 
top; thus the member start is equal to the column base). 

As the Load acts over total length of Member, we select the corresponding check box. 
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Figure 5.20: Defining wind pressure as trapezoidal member load 

We click [OK]. Now we see the member load represented on the second column. 

The RFEM graphic showing the generated and manually defined wind loads should look like 
the figure below. 

 
Figure 5.21: Wind loads 
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5.5 Checking Load Cases 
All four load cases have been completely entered. It is recommended to [Save] the input now. 

We can check each load case quickly in the graphics: The buttons [] and [] in the toolbar  
allow us to select previous and subsequent load cases. 

 
Figure 5.22: Browsing the load cases 

The loading's graphical input is also reflected in both the Data navigator tree and the tables. 
We can access the load data in table 3. Loads which can be set with the button shown on the 
left. 

Again, graphic and tables are interactive: To find a load in the table, for example a member 
wind load, we set table 3.2 Member Loads, and then we select the load in the work window. We 
see that the pointer jumps into the corresponding row of the table. 

 
Figure 5.23: Interaction between graphic and load tables 

 

    

 

 



6  Combination of Actions 

 65 RFEM Tutorial © 2020 Dlubal Software, Inc. 

 
Dlubal 

6.  Combination of Actions 
We combine the load cases according to ASCE 7. We take advantage of the generator integrat-
ed in the program to superimpose the actions with the required partial safety factors and 
combination coefficients. The relevant conditions have already been created when the model 
was defined in the dialog box General Data where we have selected the option Create combi-
nations automatically (see Figure 3.1, page 8). 

The Action Category defined for the load cases (see Figure 5.17, page 60) determines the way 
how load cases are combined in different design situations.  

6.1  Checking Actions 
The load cases must be assigned to Actions which will be superimposed in accordance with 
regulations. Actions represent independent influence values that arise from different origins. 
The correlation existing between them may be neglected with regard to the reliability of the 
structural system. 

Load cases, actions and combinations are managed in the Edit Load Cases and Combinations 
dialog box (see Figure 5.17, page 60) as well as in tables number 2. We can access these tables 
by clicking the table button shown on the left. Table 2.1 Load Cases shows us the four load 
cases with the selected action categories in a clear overview. 

 
Figure 6.1: Table 2.1 Load Cases 

The subsequent table 2.2 Actions shows us the load cases that are contained in the individual 
actions. Each load case of our example is assigned to another action. However, if we had de-
fined several wind load cases for different directions, they all would be listed in the action 
Wind. 

 
Figure 6.2: Table 2.2 Actions 
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6.2 Defining Combination Expressions 
In accordance with ASCE 7-16, we have to combine the actions for LRFD or ASD design accord-
ing to certain rules. Table 2.3 Combination Expressions shows us which limit states are set to be 
analyzed. 

 
Figure 6.3: Table 2.3 Combination Expressions 

For our example we will use only the LRFD load combinations from Section 2.3 (LRFD) in the 
ASCE 7-16. 

Section 2.4 (ASD) load combinations are also listed in this table automatically. We can click on 
any cell within this row and click the Empty Row button in the toolbar to delete these combi-
nations. If we later decide we want to analyze ASD load combinations in addition to LRFD, we 
can use the drop-down box under Design Situation to select Section 2.4 (ASD) again. 

We use the navigator shortcut menu to open the dialog box Edit Load Cases and Combinations 
and to Edit the parameters of the combination expression CE1. 

 
Figure 6.4: Navigator shortcut menu of combination expressions 
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To read describing comments informing us about the combination expression for the LRFD 
design, we use the [Info] button available in the Edit Load Cases and Combinations dialog box. 

 
Figure 6.5: Dialog box Edit Load Cases and Combinations, tab Combination Expressions 

We can see the Method of Analysis is set to Second-Order analysis (P-delta) for all load com-
binations. Each load combination generated from the ASCE 7 will be set to this analysis meth-
od. You will have the option though, in a later discussion, to set an individual load combina-
tion to another method of analysis. 

Before we close the dialog box Edit Load Cases and Combinations with [OK], we make sure that 
the option Generate additionally Either/Or result combination in the General tab is checked 
as well. This result combination provides the extreme values from the results of all load combi-
nations (envelope). 

RFEM creates the action combinations. When we click table tab 2.4 Action Combinations and 
return to table 2.3, the column Generated Action Combinations informs us that 26 combinations 
were created. 

 
Figure 6.6: Table 2.3 Combination Expressions, table column Generated Action Combinations 
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Shortcut menu Load Combinations 

6.3 Creating Action Combinations 
RFEM creates 26 action combinations (see Figure 6.6) which are listed and sorted by actions in 
Table 2.4 Action Combinations. 

 
Figure 6.7: Table 2.4 Action Combinations 

This overview corresponds to the presentation of actions described in the Standard. By selecting 
the check box in the Use column we can define the action combinations which will be considered 
for the generation of load combinations. We can see that corresponding action combinations 
that are not controlling are automatically disabled. 

6.4 Creating Load Combinations 
Eleven load combinations are automatically created from the eleven relevant action combina-
tions (see Figure 6.7). The result is listed in the next Table 2.5 Load Combinations. 

 
Figure 6.8: Table 2.5 Load Combinations 

Table columns D to K inform us about load cases including respective load factors. 

We use the navigator shortcut menu shown on the left to open the Edit Load Cases and Combi-
nations dialog box where we look at the created load combinations. 
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Figure 6.9: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

When we select the Existing Load Combinations one after the other in the list, the relevant load 
cases and their combination factors are displayed in the dialog section to the right. 

Furthermore, we can use the Calculation Parameters tab to check the specifications applied by 
RFEM for the calculation of different load combinations. Basically, load combinations are ana-
lyzed non-linearly according to the Second-order analysis (P-Delta). 

 
Figure 6.10: Checking the Calculation Parameters of a load combination 
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6.5 Checking Result Combinations 
When we defined the combination expressions, we activated the option Generate additionally 
Either/Or result combination (see Figure 6.5, page 67) giving us information about the extreme 
values of all load combinations. 

RFEM generates a results envelope from the load combinations. The definition criterion can be 
checked in the final tab of the Edit Load Cases and Combinations dialog box as well as in Table 
2.6 Result Combinations. 

 
Figure 6.11: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

All load combinations are superimposed with factor 1.00 and the criterion Permanent. They all 
are assigned to group 1, which means that they act alternatively. 

Now, the superposition criteria is completely defined. We can save the input with the [Save] 
button.  
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7.  Calculation 
 

7.1 Checking Input Data 
Before we calculate the model, we want RFEM to check our input. To open the corresponding 
dialog box, 

we select Plausibility Check on the Tools menu. 

The dialog box Plausibility Check opens where we define the following settings. 

 
Figure 7.1: Dialog box Plausibility Check 

If no error is detected after clicking [OK], a corresponding message is displayed, including 
summary of model and load data. 

 
Figure 7.2: Result of plausibility check 

We find more tools for checking the input by selecting 

Model Check on the Tools menu. 
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7.2 Generating FE Mesh 

Generate the FE mesh 
As we have selected the option Generate FE mesh in the dialog box Plausibility Check (see Figure 7.1), 
we have automatically generated a mesh with the standard mesh size of 1.00 ft. (We can modi-
fy the preset mesh size by selecting FE Mesh Settings on the Calculate menu.) 

 
Figure 7.3: Model with generated FE mesh 

Create a FE mesh refinement 
We define refinement areas for both ends of the downstand beam to generate a finer FE mesh. 

We double-click node 3 to open the dialog box Edit Node. We change to the tab FE Mesh where 
we select the check box of the option Available (see Figure 7.4). 

Since we have not yet defined any type of FE mesh refinement, the dialog box New FE-Mesh  
Refinement opens automatically. 

It is not necessary to modify the default settings Node - circular. We will edit the proposed  
Parameters however. The radius will be set to 7.00 ft, the Inner Target FE length will be set to 
0.50 ft, and the Outer Target FE length will be set to 1.00 ft. The FE mesh will be deleted after 
confirming both dialog boxes with [OK]. 
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Figure 7.4: Dialog boxes Edit Node and New FE-Mesh Refinement 

A refinement area represented as spherical form is displayed on the selected node (see Figure 7.6). 

Now, we have to transfer the FE mesh refinement to the second end node of the downstand 
beam. In the Data navigator, we double-click entry 1 listed below the FE Mesh Refinements to 
access the Edit FE-Mesh Refinement dialog box. 

We click the [Select] button in the dialog section Node No. to select the second node of the rib 
graphically in the work window. 

 
Figure 7.5: Defining the second node graphically by using the [Select] function 

We close all dialog boxes with [OK]. 
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We create the mesh once again by 

selecting Generate FE Mesh in the Calculate menu. 

Then, we check the refinement areas. 

 
Figure 7.6: FE mesh with refinement areas 

7.3 Calculating Model 
To start the calculation, 

we select Calculate All on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.7: Calculation process 
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8.  Results 
 

8.1  Graphical Results 
As soon as the calculation is complete, RFEM shows the deformations of the active load case. 

 

Figure 8.1: Graphical representation of deformations for result combination RC1 

Selecting load cases and load combinations 
We can use the toolbar buttons [] and [] (to the right of the load case list) to change among 
the results of load cases, load and result combinations. We already know those buttons from 
checking the load cases. It is also possible to select a specific load case or combination in the 
list. 

 

Figure 8.2: Load case list in the toolbar 
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Selecting results in the navigator 
A new navigator has appeared, managing all result types for the graphical display. We can ac-
cess the Results navigator when the results display is active. We can switch the results display 
on and off in the Display navigator, but we can also use the toolbar button [Show Results] 
shown on the left. 

 
Figure 8.3: Results navigator 

We can see check boxes placed in front of each result category (for example Global Deforma-
tions, Members, Surfaces, Support Reactions). When we select a box, we see the corresponding 
deformation or internal force displayed in RFEM. In front of the entries listed in the categories 
we see even more check boxes by which we can set the type of results to be displayed. 

Finally, we can browse the single load cases and load combinations. The variety of result cate-
gories allows us to display deformations, internal forces of members and surfaces as well as 
stresses or support forces. 
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The figure below shows the member internal forces Mz and the surface internal forces my 
calculated for CO10. To display the forces, it is recommended to use the wireframe model.  
We can set this display option with the button shown on the left. 

 

Figure 8.4: Representation of internal forces of members and surfaces (CO10) 

Display of values 
The color scale in the control panel informs us about the assignment of color ranges. Moreo-
ver, we can switch on the result values for particular locations by checking the option Values 
on Surfaces in the Results navigator. We check the option to display all values of the FE mesh 
On grid and user-defined points. Additionally, we deactivate the option Extreme Values. 

 

Figure 8.5: Grid point moments my of floor slab in -Z view (CO10) 
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8.2 Results Tables 
We can evaluate results also in the tables. 

Table display 
The results tables are displayed automatically as soon as the structure is calculated. Like for the 
numerical input we see various tables with results. Table 4.0 Summary offers us a summary of 
the calculation process, sorted by load cases and combinations. 

 
Figure 8.6: Table 4.0 Summary 

To select other tables, we click their table tabs. To find specific results in the table, for example 
the internal forces of the floor slab, we set Table 4.15 Surfaces - Basic Internal Forces. Now, we 
select the surface in the graphic (setting the Solid Transparent Display Model makes our selec-
tion easier), and we see that RFEM jumps to the surface's basic internal forces in the table. The 
current grid point, that means the position of the pointer in the table row, is indicated by a 
marking arrow in the graphic. 

 
Figure 8.7: Surface internal forces in Table 4.14 and marker of current grid point in the model 

Like the browsing function in the main toolbar we can use the buttons [] and [] to select the 
load cases in the table. We can also use the list in the table toolbar to set a particular load case. 
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Adjust the results grid 
The surface results shown in the tables are listed in the grid points that are defined for the sur-
face. The results grid, like the FE mesh, has a default mesh width of 1 ft. 

To refine the grid for the result values of surface 1, we double-click the floor slab in the work 
window (or the relevant entry in the Data navigator). Then, in the dialog box Edit Surface, we 
change settings in the Grid tab: We select 0.50 ft for both b and h as new distance of the grid 
points. 

 
Figure 8.8: Changing the grid for result values 

When we click [OK], RFEM updates the result values in the table. A recalculation is not required 
because the grid point results are determined from the values available in the FE nodes. 

 
Figure 8.9: Result values of surface 1 with refined grid 
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8.3 Filtering Results 
RFEM offers us different ways and tools by which we can represent and evaluate results in 
clearly-structured overviews. We can use these tools also for our example. 

8.3.1 Visibilities  
We have already worked with visibilities when we entered the steel frame (see Chapter 4.5.1, 
page 31). Those visibility functions are also useful when evaluating the results. 

Show results for concrete columns 
We set the Views tab in the navigator. We select Members by Cross-Section listed under the visi-
bilities that RFEM has Generated from the entered data. In addition, we select the check box for 
Circle 20 and activate the option User-defined / generated on top of the navigator. 

 

Figure 8.10: Moments Mz of concrete columns in scaled representation 

The display shows the concrete columns including results. The remaining model is displayed 
only in gray and without results. 

Adjusting the scaling factor 
In order to check the diagram of internal forces on the rendered model without difficulty, we 
scale the data display in the control tab of the panel. We change the factor for Member diagrams 
to 2 (see figure above). 
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Show results for floor slab 
In the same way, we can filter also surface results in the Views navigator. We clear the check 
box for Members by Cross-Section and select Surfaces by Geometry where we select the check 
box of the entry Plane. 

Now, when we change the result type with the button [Deformation] available in the toolbar, 
we see the following RFEM display. 

 
Figure 8.11: Deformations of floor 

As already described, we can change the display of result types (deformations, internal forces, 
stresses etc.) in the Results navigator (see Figure 8.3, page 76). 
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Show deformations of steel construction 
Now, in the Views navigator, we clear the check box of Surfaces by Geometry, and then we  
select Members by Material where we select the check box for Steel A992. 

 
Figure 8.12: Filtering steel members in Views navigator 

The graphic shows us the steel construction's deformations displayed as lines. 

It is also possible to display the deformations of cross-sections: We switch to the Display navigator 
where we 

select Results, Deformation, Members and Cross-sections Colored. 

We also check the Transparent box for a better view of the deformed members. 

 
Figure 8.13: Deformations of steel cross-sections 

With the panel button [Options] we can additionally activate the option Smooth color transition.  
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8.3.2 Results on Objects 
Another possibility to filter results is using the filter tab of the control panel where we can 
specify numbers of particular members or surfaces to display their results exclusively. In con-
trast to the visibility function, the model will be displayed completely in the graphic. 

First, we deactivate the option Visibilities in the Views navigator. 

 
Figure 8.14: Resetting the overall view in the Views navigator 

Then, in the Results navigator, we select the axial forces N of members. We can deactivate the 
results of Surfaces. 

 
Figure 8.15: Display settings for member axial forces N 
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Special selection 
To display only the axial forces of columns, we select all members in vertical position. RFEM  
offers special selection options available in a dialog box. Before we utilize this function, right 
click in the work window and select Show Numbering to view the node, member, and surface 
numbers graphically. 

To open the Special Selection dialog box, 

we select Select on the Edit menu, and then we click Special, 

or we use the toolbar button shown on the left. 

We select the category Members and, then, the option Parallel to member. 

 
Figure 8.16: Selecting parallel members 

Then, we use the [Select] function to click column member M7 in the work window. After 
closing the dialog boxes with [OK], all members in vertical position are highlighted. 

We will turn off the numbering by right clicking in the work window and clicking on Show 
Numbering again to disable the graphical view of the elements’ numbers. 
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Show axial forces of columns 

In the panel, we change to the filter tab where we activate the setting Members. 

We click the button [Import from Selection] and see that the numbers of all column members 
have been entered into the text box above. The axial forces of the rib as well as of the horizon-
tal beams and purlin members disappear in the graphic. 

 

Figure 8.17: Axial forces of members 

8.3.3 Range of Values 
With the color scale tab of the panel we can filter results by result values. 

First, in the Results navigator, we remove the check mark of the member results. Then, we set 
the basic internal forces nx of surfaces for display. In this case, the forces are axial forces acting 
in direction of the local surface axis x. The axis x of the curved wall surface points downwards. 

 
Figure 8.18: Setting basic internal forces nx for display 
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Looking at the wall surface, we can see high compressive forces occurring near the upper arc 
end nodes. In CO10 for example, they are introduced by both steel columns and across the rib. 
The high values are indicating singularity effects.  We also have a high tension singularity near 
node N7. 

To cut these result peaks for the evaluation, we switch into the color scale tab of the panel. We 
double-click the color spectrum (not the values!) and open the dialog box Edit Isoband Value 
and Color Scales. 

 
Figure 8.19: Changing extreme value for display and [Fill]ing the value scale 

We reduce the extreme value of the compression force as shown in the figure above, for ex-
ample for CO10 (-40.000 kip/ft instead of -174.020 kip/ft). We also redcue the extreme value of 
the tension force for CO10 (15.000 kip/ft instead of 19.152 kip/ft). Finally, we subdivide the 
value spectrum into equal ranges between top and bottom limit value by clicking the button 
[Fill]. 

After clicking [OK], the force distribution is more differentiated (see Figure 8.20). The zone 
where lifting forces occur is clearly visible. Locations of singularities not covered by the color 
scale have no colors. 



8  Results 

 87 RFEM Tutorial © 2020 Dlubal Software, Inc. 

 
Dlubal 

 

Figure 8.20: Distribution of wall axial forces with adjusted value scale (adapted peaks, compression and tension zone) 

8.4 Display of Result Diagrams 
We can evaluate results also in a diagram available for lines, members, line supports and sections 
(see Chapter 8.5). Now, we use this function to look at the result diagram of the downstand beam. 

Before doing this, we want to clear the special selection for all columns that was previously de-
scribed (see Figure 8.17, page 85).  In the Panel, we click the row of the selected beams to high-
light it. By clicking on the [Delete Selected Row] button, the special selection will be cleared. 

 
Figure 8.21: Clear the Special Selection View 
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Shortcut menu Member 

Moving on to the results diagram, we right-click member 3 (when we have problems we can 
switch off the surface results) and select the option Result Diagrams in the shortcut menu. 

A new window opens displaying the result diagrams of the rib member. 

 
Figure 8.22: Display of result diagrams of downstand beam 

In the navigator, we select the check boxes for the global deformations u and the internal forces 
My/Mu and VL. The last option represents the longitudinal shear force between surface and 
member. These forces are displayed when the button [Results with Ribs Component] is set ac-
tive in the toolbar. When we click the button to turn it on and off, we can clearly see the differ-
ence between pure member internal forces and rib internal forces with integration compo-
nents from the surfaces. 

To adjust the size of the displayed result diagrams, we use the buttons [+] and [-]. 

The buttons [] and [] for load case selection are also available in the result diagram window. 
But we can also use the list to set the results of a load case. 

We quit the function Result Diagrams by closing the window. 
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Selecting midpoint of line 1 
 

8.5 Creating Section 
The evaluation is made easier by user-defined sections defined as planes slicing through the 
model. The navigator manages all sections as independent objects. 

To create a new section, 

we select Section on the Insert menu 

or we use the section shortcut menu in the Data navigator. 

 
Figure 8.23: Shortcut menu Sections in Data navigator 

The dialog box New Section opens where we enter the Section Name Center because we want 
to define the section along the plate center. 

Then, we define the edge points of the section graphically by using the [Select] function: We 
click the midpoint of line 1 (global coordinates 0.00/10.00/0.00), and then we select arc node 5. 

 
Figure 8.24: Defining the section 

We also check the Show result diagrams in dialog box option. We accept the remaining pre-
settings and confirm the dialog box with [OK]. 
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The familiar Result Diagram window appears. In the navigator, we select the check boxes for 
the global deformations u and the basic internal forces mx and nx. The results of the surfaces S1 
and S2 caught by the section are displayed continuously on a line. 

 
Figure 8.25: Section display in Result Diagram window 

We [Close] the Result Diagram window. Now, we see the section as well displayed in the RFEM 
work window where we set the basic internal forces mx. 

We switch off the surface results to display only the diagrams of the section (see Figure 8.27). 

With the filled display option for sections available in the Display navigator we can highlight 
the moment diagram in the model. 

 
Figure 8.26: Display options for sections in Display navigator 
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Figure 8.27: Showing the section in the model 
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9. Documentation 
 

9.1  Creating Printout Report 
It is not recommended to send the complex results output of an FE calculation directly to the 
printer. Therefore, RFEM generates a print preview first, which is called "printout report" con-
taining input and results data. We use this report to determine the data that we want to in-
clude in the printout. Moreover, we can add graphics, descriptions, or scans. 

To open the printout report, 

we select Open Printout Report on the File menu 

or we use the button shown on the left. A dialog box appears where we can click the [New 
Printout Report] button then specify a Template as a sample for the new printout report. 

 
Figure 9.1: Dialog box New Printout Report 

We accept template 1 - Input data and reduced results and generate the print preview with [OK]. 

 
Figure 9.2: Print preview in printout report 
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9.2 Adjusting the Printout Report 
The printout report has a navigator similar to RFEM, listing the selected chapters. By clicking a 
navigator entry we can see its contents displayed in the window to the right. 

The preset contents can be specified in detail. To adjust the output of internal forces, we right-
click 4.12 Cross Sections - Internal Forces under the chapter Results - Result Combinations. Then 
we click Selection in the shortcut menu. 

 
Figure 9.3: Shortcut menu Members - Internal Forces  

A dialog box appears, offering detailed selection options for RC results of members (see Figure 9.4). 
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Figure 9.4: Reducing output of internal forces by means of Printout Report Selection 

We place the pointer in table cell 4.12 Cross-Sections - Internal Forces (see Figure 9.4). The button 
[...] becomes active which opens the dialog box Details - Internal Forces by Cross Section. Now, 
we reduce the output to the Extreme values of the member internal forces N, Vz, My and Mz. 

After confirming the dialog boxes, RFEM adjusts the output of internal forces accordingly. 

 
Figure 9.5: Extreme values of member internal forces N, Vz, My and Mz in printout report 
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In the same way, we can adjust all remaining chapters for the printout. 

To change the position of a chapter within the printout report, we move it to the new position 
by using the drag-and-drop function. When we want to delete a chapter, we use the shortcut 
menu (see Figure 9.3) or the [Del] key on the keyboard. 

9.3 Inserting Graphics in Printout Report 
Generally, graphics illustrating the documentation are included in the printout. 

Printing deformation graphics 
We close the printout report with the [X] button. The program asks us Do you want to save the 
printout report? We confirm this query and return to the work window of RFEM. 

In the work window, we set the Deformations of RC1 - CO1/p or to CO11. Furthermore, we de-
activate the Sections in the Results navigator. 

RFEM provides two results for each result combination, the maximum and minimum extreme 
values. Both values are displayed at the same time in the graphic. For our printed graphic we 
reset the display to show only the Max-values. 

 
Figure 9.6: Showing the maximum deformation results of RC1  

Now, we transfer this graphical representation to the printout report. 

We select Print Graphic on the File menu 

or we use the toolbar button shown on the left. 

The dialog box Graphic Printout appears (see Figure 9.7). 
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Figure 9.7: Dialog box Graphic Printout 

We set the print parameters as shown in Figure 9.7. We do not need to modify the settings of 
the other dialog tabs. 

We click [OK] to print the deformation graphic into the printout report. The graphic appears at 
the end of chapter Results - Result Combinations. 

 
Figure 9.8: Deformation graphic in printout report 
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Printing result diagrams 
Finally, we want to document the distribution of internal forces available in a steel purlin.  
We close the printout report again by using the button [X]. 

Back in the RFEM work window, we right-click member 11 (purlin on high eaves). The mem-
ber's shortcut menu opens (see page 88) where we select the option Result Diagrams to access 
the result diagram. 

 
Figure 9.9: Shear force and moment diagram of purlin 

The window shows the result diagrams of RC1. For our printout we select only the check boxes 
of the internal forces Vz and My. The result diagram shows us the Max and Min Values. 

With the [Print] button we open the dialog box Graphic Printout. We can keep the default set-
tings of the tab General. In the Options tab, we change some settings. 

 
Figure 9.10: Dialog box Graphic Printout, tab Options 
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We transfer the graphic to the printout report with [OK]. 

 
Figure 9.11: Diagrams of internal forces for purlin in printout report 

Changing the language in the printout report 
The language in the printout report can be selected independently of the language that is set 
for the RFEM user interface. Thus, we are able to create for example a German printout report 
in the English version. To activate the function, 

we select Language on the Settings menu of the printout report. 

 
Figure 9.12: Switching languages in printout report 

In the dialog box Languages, we set German (or another language) as the new language. We 
can check the corresponding modifications in the print preview when we click [OK]. 

User-defined entries such as load case descriptions or comments won't be translated. We can 
then go back to English (USA) with the same steps mentioned above. 
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Printing the printout report 
When the printout report is completely prepared, we can send it to the printer by using the 
[Print] button. 

The PDF print device integrated in RFEM makes it possible to put out report data as a PDF file.  
To activate this function, 

we select Export to PDF on the File menu. 

In the Windows dialog box Save As, we enter file name and storage location. 

By clicking the [Save] button we create a PDF file with bookmarks facilitating the navigation in 
the digital document. 

 
Figure 9.13: Printout report as PDF file with bookmarks 
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10.  Outlook 
Now we have reached the end of our example. We hope that this tutorial helps you to get 
started with RFEM and makes you curious to discover more of the program functions. You can 
find a detailed program description in the RFEM manual that you can download on our website. 

With the Help menu or the [F1] key it is possible to open the program's online help system 
where you can search for particular terms like in the manual. The help system is based on the 
RFEM manual. 

Finally, if you have any questions, you are welcome to use our free e-mail hotline or consult the 
FAQ or Knowledge Base pages on our website. 

This example can be continued in the add-on modules, for example for steel and reinforced 
concrete design (RF-STEEL Members/AISC, RF-CONCRETE Surfaces/ Members, or RF-STABILITY). 
To comply with the demo restrictions of the RF-STEEL AISC module, for example, you can re-
place the cross-sections of the steel beams by W 12x26 sections. In this way, you will be able to 
perform the design, get an insight into the functionality of the add-on modules. 

 

 

 

 

https://www.dlubal.com/en-US/downloads-and-information/documents/manuals?category=rfem
https://www.dlubal.com/en-US/support-and-learning/support/faq
https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base
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